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Privire de ansamblu

Acest capitol vă face cunoştinţă cu Calc, componenta de calcul tabelar din suita de programe 
OpenOffice.org 2.0.

Copyright şi m rci înregistrateă
Conţinutul acestui document este protejat de Licenţa de Documentaţie Publică, versiunea 1.0 
(numită în continuare Licenţa); aveţi permisiunea de a folosi această documentaţie numai dacă 
sunteţi  de  acord  cu  prevederile  licenţei.  O  copie  a  licenţei  este  disponibilă  la  :
http://www.openoffice.org/licenses/PDL.rtf.

Documentaţia originală a fost scrisă în limba engleză şi este intitulată Să începem să lucrăm cu
Calc:  Componenta de calcul tabelar din OpenOffice.org. Autorul primei versiuni este  <Peter
Kupfer> © <2005>.  Toate  drepturile  rezervate.  (îl  puteţi  contacta  la 
<peschtra_ooo@yahoo.com>).  Contactaţi  autorul  numai  pentru  a  semnala  erori  în 
documentaţie. Pentru întrebări despre cum să folosiţi programul, înscrieţi-vă pe lista de mail 
pentru utilizator şi  scrieţi  întrebările  dumneavoastră acolo. Lista de mail  o găsiţi  la adresa 
http://support.openoffice.org/index.html.)

Şi-au adus contribuţia şi Rick Barnes, Jean Hollis Weber. 

Toate mărcile înregistrate menţionate în acest capitol aparţin utilizatorilor legitimi.

P rerea dumneavoastră ă
Dacă  doriţi  să  faceţi  comentarii  sau  sugestii  despre  acest  document  vă  rog  să  scrieţi  la 
authors@user-faq.openoffice.org.  Pentru  versiunea  în  limba  română,  adresa  este 
dev@ro.openoffice.org.

Mul umiriţ
Dave  Le  Huray  şi  Jim  Taylor  au  scris  versiunea  anterioară  a  acestui  document  pentru 
OpenOffice.org 1.1. 
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Modific ri şi actualiz riă ă

Versiune Data Descrierea modific riiă

0.1 23. Jan. 2005 Initial update for V2.0

0.2 01/25/05 Accepted edits from RBarnes 

0.3 01/30/05 Accepted edits from JHW

0.3 06/03/05 Tradus în limba română
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Ce este Calc?

Calc este componenta de calcul tabelar din suita OpenOffice.org (OOo). Puteţi introduce date - 
de obicei date numerice - într-o foaie de calcul şi apoi să lucraţi cu aceste date pentru a vă face 
treaba.

Alternativ puteţi introduce date şi apoi să le folosiţi în Calc pentru a face diverse teste sau a 
vedea rezultatul unor ipoteze, deoarece după introducerea noilor date puteţi observa rezultatul 
fără a reintroduce restul datelor.

Unul dintre avantajele majore ale unei foi de calcul eletronice este ca datele sunt foarte uşor şi 
simplu de modificat. Dacă aţi folosit corect funcţiile şi formulele, programul va ţine cont de 
noile date şi va recalcula foaia de calcul automat.

Registre, pagini şi celule

Calc lucrează cu registre (workbooks). Registrele constau dintr-un număr de pagini individuale 
(worksheets), fiecare conţinând un bloc de celule ordonate pe rânduri şi coloane.

Aceste celule păstrează elementele individuale —text, numere, formule etc.—pe baza cărora se 
fac calculele şi se determină ce se va afişa pe ecran.

Fiecare registru poate avea mai multe pagini,  iar fiecare pagină poate avea aproximativ 16 
milioane  de  celule.  În versiunea  2.0  a  OOo,  fiecare  pagină  poate  avea  maximum 65,536 
rânduri (de la 1 la 65536) şi maximum 245 coloane (de la "A" la "IV"). Aceasta înseamnă 
16,056,320 celule pentru fiecare pagină.

Numărul maxim de rânduri a fost crescut de la OOo 1.x la 2.0. În 1.0 erau numai 
32,000 rânduri.
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Fereastra principal  Calcă

Când Calc este pornit, fereastra aplicaţiei arată ca în Imaginea 1.

Imaginea 1. Elementele ferestrei Calc

Titlul şi meniul
Titlul, situat cel mai sus, arată numele registrului în lucru. Dacă registrul este nou creat şi nu a 
fost denumit, numele său este  Untitled  X, X fiind un număr. Când îl veţi salva pentru prima 
dată, vi se va cere să îl denumiţi.

În OOo 2.0 în titlu este afişat numele fişierului în loc de titlul documentului. De 
asemenea, versiunea OOo nu mai este afişată.

Sub titlu se găseşte meniul. Când alegeţi unul dintre elementele meniului, apare un submeniu, 
oferind alte opţiuni. Meniul poate fi modificat, acest lucru fiind explicat în capitolul intitulat 
"Meniuri  şi  panouri  cu  unelte"  (“Menus  and Toolbars”)  din  ghidul  Să începem (Getting 
Started).
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Panouri cu unelte
În mod obişnuit,  sub  Meniu  sunt  situate  trei  panouri  cu  unelte:  panoul  Standard,  panoul 
Formatare şi panoul Formule.

Panourile  în  OOo 2.0  nu  mai pot  fi  verticale,  aşa  cum puteau fi  în  1.x.  Totuşi, 
panourile  pot  fi  plasate  pe  verticală  pe  marginile  ecranului,  dacă le  trageţi  chiar 
dumneavoastră.

Butoanele  grafice  de  pe  panouri  asigură  accesul  la  o  larga  gamă  de  comenzi  şi  funcţii. 
Panourile pot fi modificate, acest lucru fiind explicat în capitolul intitulat "Meniuri şi panouri 
cu unelte" (“Menus and Toolbars”) din ghidul Să începem (Getting Started).

Dacă ţineţi mausul deasupra unui buton grafic se afişează un scurt text de ajutor, numit pontul 
uneltei (tooltip). Pentru explicaţii mai detaliate,  selectaţi  Ajutor > Ce este aceasta? (Help > 
What's This?) şi ţineţi mausul deasupra butonul grafic care vă interesează.

Ponturile extinse (extended tips) din OOo 2.0 nu mai sunt disponibile din meniul 
Ajutor  (Help).  Ponturile (scurte sau extinse) pot fi activate sau dezactivate de la 
Unelte  >  Opţiuni  >OpenOffice.org  >  Generalităţi  (Tools  >  Options  > 
OpenOffice.org > General). Opţiunea Ce este aceasta? este o nouă formă de ajutor 
pentru utilizator în OOo 2.0.

În panoul Formatare, sunt două zone dreptunghiulare în partea stângă. Sunt două meniuri care 
se  numesc  Numele  fontului  (Font  Name) şi  Mărimea  Fontului  (Font  Size).  (vedeţi 
Imaginea 4).  Ce este  deja scris în ele  (dacă este ceva scris) vă indică setările  respective 
curente.

Imaginea 2. Numele fontului şi mărimea acestuia.

Daţi clic pe micul  buton din partea dreaptă a fiecărui  dreptunghi (cel  care vă sugerează o 
derulare  în  jos)  pentru  a  deschide  lista  fonturilor,  respectiv  a  dimensiunilor  acestora.  Din 
meniurile  Numele fontului  (Font Name) şi  Mărimea fontului  (Font Size) puteţi  schimba 
fontul  şi  dimensiunea sa în celulele  selectate.  La  Mărimea fontului  (Font Size) puteţi  să 
introduceţi dimensiuni cu zecimale.

Dacă vă place să folosiţi tastatura, în ambele dreptunghiuri puteţi scrie direct numele fontului 
respectiv mărimea acestuia. Trebuie să apăsaţi Enter pentru ca aceste setări să fie aplicate.
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Panoul Formule
În partea stângă a panoului Formule (vedeţi în Imaginea 3) este un câmp dreptunghiular, numit 
Nume (Name), care conţine o literă şi un număr, de exemplu  D7.  Acestea indică rândul şi 
coloana celulei curente (care mai este denumita celulă de referinţă).

Imaginea 3. Panoul Formule

La dreapta câmpului Nume sunt Vrăjitorul Funcţie şi butoanele Sumă şi Funcţie.

Dacă daţi clic pe  Vrăjitorul Funcţie (Function Wizard) se va deschide o casetă de dialog 
unde puteţi căuta prin lista funcţiilor disponibile. Este de obicei foarte folositoare, mai ales că 
arată şi cum sunt formatate funcţiile.

Butonul  Sum(ă) inserează  în  celula  curentă  o  formulă  care  calculează  suma celulelor  de 
deasupra sau, dacă celula de deasupra nu conţine numele, cele de la stânga.

Butonul  Funcţie  (Function) inserează  un  semn de  egalitate  ('=')  în  celula  selectată  şi  în 
câmpul Formulă, celula fiind astfel pregătită să accepte o formulă.

Pe timpul cât introduceţi date noi într-o celulă ce deja conţinea ceva, butoanele Sum(ă) şi Egal 
(Equals) sunt înlocuite de butoanele Anulează (Cancel) şi Accept  .

Conţinutul celulei curente (date, formule sau funcţii) este afişat în câmpul Linia de introducere 
(Input Line), care face parte din panoul Formule. Puteţi edita conţinutul celulei curente direct 
în acest câmp, sau puteţi să editaţi în celula curentă. Pentru a edita în Linia de introducere, daţi 
clic - stânga unde doriţi să poziţionati cursorul în cadrul textului din Linia de introducere, apoi 
puteţi să scrieţi. Pentru a edita celula curentă este suficient să daţi dublu-clic pe aceasta.

Celule individuale
Cea mai mare parte a ecranului afişează celulele sub forma unei reţele, fiecare celulă fiind 
situată la intersecţia dintre un rând şi o coloană.

Deasupra coloanelor şi în partea stângă a rândurilor sunt o serie de celule gri conţinând litere şi 
numere.  Acestea sunt capetele  de coloană şi  de rând. Coloanele încep cu 'A'  şi  cresc spre 
dreapta, rândurile încep cu '1' şi cresc în jos.

Aceste capete de coloană şi de rând alcătuiesc coordonatele celulei (referinţele celulei) care 
apar în câmpul  Nume (dacă sunt selectate mai  multe  celule,  câmpul  va afişa coordonatele 
celulei stânga - sus şi dreapta - jos) de pe panoul Formule (vedeţi Imaginea 3). Afişarea acestor 
capete poate fi comutată (între vizibil şi invizibil) selectând Vizualizare > Capete de Coloană 
şi rând (View > Column & Row Headers).
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Cotoarele paginilor (Sheet tabs)
În partea  de  jos  a  fiecărei  pagini,  sub  reţeaua  de  celule,  sunt  cotoarele  paginilor  (vedeţi 
Imaginea 4). Aceste cotoare oferă accesul la fiecare pagină, iar cotorul paginii active este alb.

Dacă daţi clic pe alt cotor se va afişa pagina corespunzătoare, iar cotorul va deveni alb. Puteti 
deasemenea să selectaţi mai multe cotoare simultan ţinând apăsată tasta Control în timp ce daţi 
clic cu mausul pe cotoare.

Imaginea 4. Cotoarele paginilor (Sheet tabs)

Administrarea fişierelor

Crearea unui nou registru
Puteţi crea un nou registru pentru Calc din oricare componentă a suitei OOo. De exemplu, un 
registru poate fi creat din Writer sau Draw.

Din meniul Fişier (File)

Daţi clic pe meniul Fişier (File) şi apoi selectaţi Nou > Foaie de calcul (New > Spreadsheet).

Din panoul cu unelte

Folosiţi butonul Document Nou (New Document)   de pe panoul Standard. (Acest buton 
crează întotdeauna un document de tipul ultimului document creat de la buton, iar la început 
este propus document nou de tipul documentului curent. Pictograma afişată corespunde tipului 
de document ce va fi creat). Dacă ţineţi apăsat butonul mausului deasupra acestui buton se va 
deschide un meniu de unde puteţi alege tipul documentului care va fi creat, inclusiv Foaie de 
calcul (Spreadsheet). Acest meniu poate fi accesat si dând un simplu clic pe săgetuţa neagră de 
lângă pictogramă.

De la tastatură
Dacă tocmai editaţi într-un registru puteţi apăsa Control+N pentru a crea un alt registru.

Deschiderea registrelor existente

Din meniul Fişier (File)

Dati clic pe meniul Fişier (File) şi apoi selectaţi Deschide (Open).

Din panoul cu unelte

Daţi clic pe butonul Deschide (Open)  de pe panoul Standard.
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De la tastatură
Apăsaţi Control+O.

Oricare dintre aceste opţiuni deschide caseta de dialog Deschide  (Open) (Imaginea 5), unde 
puteţi regăsi registrul (fişierul) pe care doriţi să îl deschideţi.

Imaginea 5. Caseta de dialog Deschidere fişier (Open File).

PONT Puteţi  să  redeschideţi  un  registru  deschis  recent  selectându-l  din  lista  Fişierelor 
deschise recent (Recently Opened Files). Această listă se găseşte în meniul  Fişier 
(File), chiar sub  Deschide (Open). Această listă conţine ultimele 10 fişiere care au 
fost deschise în oricare dintre componentele OOo.

Deschiderea pe baza unui şablon (template)
Documentele  Calc pot fi  create şi  pe baza unor şabloane,  dacă aveţi  şabloane disponibile. 
Procedaţi ca mai sus, dar în loc să alegeţi din meniu Foaie de calcul (Spreadsheet), selectaţi 
Şabloane şi documente  (Templates and Documents). În fereastra Şabloane şi documente, 
mergeţi  la  dosarul  (folder-ul)  corespunzător şi  dati  dublu  -  clic  pe săblonul  dorit.  Un nou 
registru, bazat pe acel şablon, se deschide.
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Salvarea registrelor

Registrele pot fi salvate în trei modalităţi.

Din meniul Fişier (File)

Dati clic pe meniul Fişier (File) şi apoi selecta iţ  Salvează (Save).

Din panoul cu unelte

Daţi clic pe butonul  Salvează (Save)   de pe panoul Funcţii (Function). Acest buton va fi, 
după  salvarea  fişierului,  colorat  în  gri  şi  nu  va  mai  putea  fi  apăsat  (cât  timp nu  au  loc 
modificări asupra registrului).

De la tastatură
Apăsaţi Control+S.

Dacă registrul nu mai fusese salvat, atunci oricare dintre acţiunile de mai sus vor conduce la 
apariţia casetei de dialog Salvează sub numele de (Save As) (Imaginea 6). Aici puteţi specifica 
numele registrului şi unde să fie acesta salvat.

Imaginea 6. Caseta de dialog Salvează sub numele de (Save As )

Notă Dacă registrul mai fusese salvat, atunci o nouă salvare conduce la pierderea vechiului 
conţinut. Dacă vreţi să salvati registrul sub un nou nume sau în altă parte selectaţi 
Fişier > Salvează sub numele de (File > Save As).
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Deplasarea în registru

Selectarea unei celule individuale

Folosind mausul

Plasaţi mausul deasupra celulei şi daţi clic - stânga.

Folosind o referin  de celulţă ă
Daţi  clic  pe  săgetuţa  de  lângă  câmpul  Nume (Imaginea  3).  Coordonatele  celulei  vor  fi 
evidenţiate.  Tastaţi  noile  coordonate şi  apăsaţi  Enter. Sau daţi  clic în câmpul  Nume,  apoi 
apasaţi tasta Backspace şi apoi tastaţi noile coordonate.

Folosind Navigatorul

Daţi  clic  pe  butonu  Navigator  din  panoul  Standard (sau  apăsaţi  F5)  pentru  a  afişa 
Navigatorul. Tastaţi  coordonatele  celulei  în  cele  două  câmpuri  de  sus,  denumite  Coloană 
(Column) şi Rând (Row), şi apăsati Enter. În Imaginea 7 Navigatorul va selecta celula F5.

Imaginea 7. Navigatorul din Calc 
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Deplasarea de la o celul  la altaă
În registru,  o celulă  (este posibil  să fie  şi  mai multe)  are o margine neagră mai  evidentă. 
Această margine indică unde este focusul (vedeţi Imaginea 8).

 
Imaginea 8. (Stânga) O singură celulă şi (dreapta) un grup de celule selctate

Folosind tastele Tab şi Enter

• Apăsarea Enter sau Shift+Enter mută focusul în jos sau în sus, respectiv.

• Apăsarea Tab sau Shift+Tab mută focusul la dreapta sau la stânga, respectiv.

Folosind tastele cursor

Apăsarea tastelor cursor mută focusul în direcţia săgeţilor.

Folosind tastele Home, End, Page Up şi Page Down

• Home mută focusul la începutul rândului.

• End mută focusul la coloana ce conţine date situată cel mai la dreapta.

• Page Down vizualizează celulele aflate un ecran mai jos, iar Page Up pe cele aflate cu 
un ecran mai sus.

• Combinaţiile Control şi Alt cu Home, End, Page Down, Page Up, şi tastele cursor mută 
focusul în şi mai multe feluri. Tabelul 1 descrie toţi acceleratorii de tastatură pentru 
deplasarea în cadrul unui registru şi unei pagini.

PONT Dacă ţineţi apăsate Alt+tastă Cursor redimensionaţi celula.
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Tabelul 1. Deplasarea de la o celulă la alta folosind tastatura

Combina ia de tasteţ Deplasarea

→ La dreapta o celulă

← La stânga o celulă

↑ În sus cu o celulă

↓ În jos cu o celulă

Control+→ La ultima coloană care conţine date sau la coloana IV

Control+← La  prima  coloană  conţinând  date  (pe  acel  rând)  sau  la 
coloana A

Control+↑ La primul rând conţinând date în acea coloană sau la rândul 
1

Control+↓ La ultimul  rând din acea coloană ce conţine date  sau la 
rândul 65.536

Control+Home La celula A1

Control+End La celula din extremitatea dreapta - jos care conţine date

Alt+PgDn Un ecran la dreapta (dacă este posibil)

Alt+PgUp Un ecran la stânga (dacă este posibil)

Control+PgDn O pagină la dreapta (în ordinea cotoarelor)

Control+PgUp O pagină la stânga (în ordinea cotoarelor)

Tab O celulă la dreapta

Shift+Tab O celulă la stânga

Enter O celulă în jos

Shift+Enter O celulă în sus

Mutarea de la o pagin  la altaă
Fiecare pagină dintr-un registru este independentă de celelalte, deşi pot fi create referinţe între 
pagini. Sunt trei modalităţi de a naviga între diferitele pagini dintr-un registru.

Folosind tastatura

Apăsarea Control+PgDn mută o pagină la dreapta iar apăsarea Control+PgUp mută o pagină 
la stânga.

Folosind mausul

Selectaţi o pagină dând clic pe cotorul ei (vedeţi Imaginea 4).

Dacă aveţi multe pagini, cotorul unora nu va putea fi afişat din cauza spaţiului limitat. În acest 
caz, cele patru butoane de la stânga cotoarelor derulează cotoarele prin zona vizibilă. Imaginea
9 exemplifică aceasta.
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Imaginea 9. Butoanele cu săgeţi de lângă cotoare.

Observaţi că paginile nu sunt numerotate, ci au diferite denumiri. Puteţi să le denumiţi după 
bunul plac.

Notă Butoanele cu săgeţi din Imaginea 9 apar numai dacă nu pot fi afişate toate cotoarele. 
Altfel vor apărea dezactivate ca în Imaginea 4.
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Selectarea  elementelor  unei  pagini  sau  ale 
unui registru

Selectarea celulelor
Celulele pot fi selectate într-o varietate de combinaţii şi de cantităţi.

O singur  celulă ă
Daţi clic - stânga în celulă. Rezultatul va arăta ca în partea din stânga din Imaginea 4. Puteţi să 
verificaţi selecţia privind la câmpul Nume.

Bloc continuu de celule

Un bloc de celule pot fi selectate folosind tastatura sau mausul.

Pentru a selecta un bloc de celule prin tragere cu mausul:

1) Daţi clic într-o celulă.

2) Apăsaţi şi ţineţi apăsat butonul stâng al mausului.

3) Deplasaţi mausul pe ecran.

4) După ce aţi selectat blocul de celule dorit, eliberaţi butonul mausului.

Pentru a selecta un bloc de celule cu mausul fără tragere:

1) Daţi clic într-o celulă care va fi colţul viitorului bloc.

2) Deplasaţi mausul la colţul din diagonală al blocului de celule dorit.

3) Apăsaţi tasta Shift şi dati clic.

Pentru a selecta un bloc de celule fără a folosi mausul:

1) Selectaţi celula care va fi colţul viitorului bloc.

2) Ţinând apăsată tasta Shift, folosiţi tastele cursor pentru a selecta restul blocului.

Rezultatul oricăreia dintre aceste metode este arătat în partea dreaptă în Imaginea 4.

PONT Puteţi să selectaţi direct blocul de celule folosind câmpul Nume. Daţi clic în câmp 
după cum a fost  descris  în  “Folosind o referinţă de celulă” la pagina  8. Pentru a 
selecta un bloc de celule, introduceţi coordonatele celulei din stânga - sus, urmate de 
două-puncte (:), şi apoi coordonatele celulei din dreapta - jos. De exemplu, pentru a 
selecta blocul ale cărui colţuri în diagonală sunt celulele A3 şi C6, introduceţi A3:C6.

Bloc discontinuu de celule

1) Selectaţi o celulă sau un bloc de celule folosind una din metodele de mai sus.

2) Deplasaţi mausul la începutul următorului bloc continuu sau a celulei individuale.
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3) Ţineţi  apăsată tasta  Control şi  daţi  clic sau ţineţi  apăsat butonul  mausului  şi  trageţi 
pentru a selecta un bloc continuu. 

4) Repetaţi de câte ori este necesar .

În  OOo v2.0 când selectaţi  blocuri  discontinue  de  celule,  prima selecţie  nu  este 
obligatoriu să fie un bloc continuu de celule (adică obligatoriu mai multe celule). În 
OOo 1.x  trebuia  să  selectaţi  mai  mult  de  o  celulă  ca  primă  parte  a  unui  bloc 
discontinuu de celule.

Selectarea coloanelor şi a rândurilor
Coloane şi rânduri întregi pot fi selectate foarte repede în OOo.

O singur  coloană ă
Coloanele pot fi selectate dând clic - stânga pe capul de coloană respectiv (vedeţi Imaginea 1). 
Va fi selectată întreaga coloană.

Un singur rând

Daţi clic pe capul de rând pentru a selecta întreg rândul.

Coloane şi rânduri multiple

Dacă doriţi să selectaţi toate celulele de pe pagină puteţi să daţi clic pe micul pătrat de la 
intersecţia capetelor de coloană cu capetele de rând.

Pentru a selecta coloane sau rânduri multiple care sunt continue:

1) Daţi clic pe prima coloană sau primul rând din grup.

2) Ţineţi apăsată tasta Shift.

3) Daţi clic pe ultima coloană sau ultimul rând din grup.

Pentru a selecta coloane sau rânduri multiple care nu sunt continue:

1) Daţi clic pe prima coloană sau primul rând din grup.

2) Ţineţi apăsată tasta Control.

3) Daţi  clic  pe  următoarea  coloană  sau  următorul  rând  din  grup,  ţinând apăsată  tasta 
Control.

Toat  paginaă
Dacă doriţi să selectaţi toate celulele de pe pagină puteţi să daţi clic pe micul pătrat de la 
intersecţia capetelor de coloană cu capetele de rând (langă coloana 'A' şi rândul '1').
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Imaginea 10. Selectaţi toate celulele.

Puteţi să selectaţi toate celulele de pe pagină apăsând Control+A.

Selectarea paginilor
Puteţi selecta una sau mai multe pagini. Este mai avantajos să selectaţi mai multe pagini dacă 
doriţi să faceţi aceeaşi modificare pe toate paginile dintr-o dată.

O singur  pagină ă
Daţi clic pe cotorul paginii pe care doriţi să o selectaţi. Cotorul paginii curente va deveni alb. 
(vedeţi Imaginea 4).

Mai multe pagini succesive

Pentru a selecta pagini succesive:

1) Daţi clic pe cotorul primei pagini.

2) Deplasaţi mausul deasupra cotorului ultimei pagini.

3) Ţineţi apăsată tasta Shift şi daţi clic pe cotorul ultimei pagini din serie.

Toate cotoarele dintre cele 2 pagini (de început şi de sfârşit) vor deveni albe. Orice modificare 
pe care o efectuaţi va afecta toate aceste pagini.

Mai multe pagini disparate

Pentru a selecta pagini disparate:

1) Daţi clic pe cotorul primei pagini.

2) Deplasaţi mausul deasupra cotorului următoarei pagini.

3) Ţineţi apăsată tasta Control şi daţi clic pe cotorul următoarei pagini.

4) Repetaţi de câte ori este necesar.

Cotoarele selectate vor deveni albe. Orice modificare pe care o efectuaţi va afecta toate aceste 
pagini.

Toate paginile

Daţi  clic - dreapta  deasupra oricărui cotor şi  alegeţi  Selectează toate paginile  (Select All 
Sheets) din meniul care apare.
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Lucrul cu rânduri şi coloane

Inserarea coloanelor şi a rândurilor
Colanele şi rândurile pot fi inserate în câteva modalităţi şi cantităţi.

O singur  coloan  / Un singur rândă ă
O singură coloană sau un singur rând pot fi inserate folosind meniul Inserare (Insert):

1) Selectaţi coloana sau rândul unde doriţi ca noua coloană sau noul rând să fie inserate.

2) Selectaţi,  după  caz,  Inserare  > Coloană  (Insert  > Column)  ori  Inserare  > Rând 
(Insert > Row).

Notă Când  inseraţi  o  singură  coloană,  este  inserată  la  stânga  coloanei  curente.  Când 
inseraţi un rând, este inserat deasupra rândului curent.

O singură coloană sau un singur rând pot fi inserate şi folosind mausul:

1) Selectaţi coloana sau rândul unde doriţi ca noua coloană sau noul rând să fie inserate.

2) Daţi clic - dreapta pe capul coloanei respectiv rândului.

3) Selectaţi Inserare rând (Insert Row) sau Inserare coloană (Insert Column).

În  OOo 2.0 când deschideţi  un meniu contextual  folosind butonul  din dreapta al 
mausului, se deschide la poziţia curentă a mausului. În versiunile anterioare ale OOo 
meniul contextual era al obiectului selectat, dar acum aparţine de obiectul deasupra 
căruia se află mausul.

Coloane sau rânduri multiple

Coloanele sau rândurile multiple poat fi inserate dintr-o dată, nefiind nevoie să le inseraţi unul 
câte unul.

1) Selectaţi  atâtea rânduri  sau coloane doriţi  să inseraţi,  dând clic cu mausul  deasupra 
rândului sau coloanei unde doriţi să inseraţi şi ţinând apăsat butonul stânga al mausului.

2) Procedaţi ca atunci când inseraţi un singur rând sau o singură coloană.

Ştergerea coloanelor şi rândurilor
Coloanele şi rândurile pot fi şterse individual sau în grupuri.

O singur  coloan  / Un singur rândă ă
O singură coloană sau un singur rând pot fi şterse folosind mausul:

1) Selectati coloana sau rândul de şters.

2) Daţi clic - dreapta pe capul de rând sau coloană.
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3) Selectaţi Şterge coloana (Delete Column) sau Şterge rândul (Delete Row) din meniul 
contextual.

Coloane sau rânduri multiple

Coloanele sau rândurile multiple pot fi şterse dintr-o dată, nefiind necesar să fie şterse unul 
câte unul.

1) Daţi clic - stânga cu mausul deasupra primului rând, respectiv deasupra primei coloane 
şi  deplasaţi  mausul  deasupra rândurilor  sau  coloanelor  pe  care doriţi  să  le  ştergeţi. 
Acestea vor fi selectate.

2) Procedaţi ca atunci când ştergeţi un singur rând sau o singură coloană.
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Lucrul cu pagini

Ca şi orice alt element din Calc, paginile pot fi inserate, şterse şi redenumite.

Inserarea unei pagini noi
Sunt mai multe  modalităţi  de a insera o nouă pagină.  Primul  pas în toate cazurile  este să 
selectaţi pagina lângă care va fi inserată noua pagină. Apoi următoarele variante pot fi folosite:

• Daţi clic pe meniul Inserează (Insert), şi selectaţi Pagină (Sheet), sau

• Daţi clic - dreapta pe cotor şi selectaţi Inserează pagină (Insert Sheet), sau

• Daţi clic într-un spaţiu gol de după ultimul cotor (vedeţi Imaginea 11).

Imaginea 11. Crearea unei noi pagini.

Fiecare metodă va deschide caseta de dialog Inserare pagină (Insert Sheet) (Imaginea 12). De 
aici puteţi selecta dacă inserţia se va face înainte sau după pagina curentă şi câte pagini vreţi să 
inseraţi.

Imaginea 12. Caseta de dialog Inserare pagină (Insert Sheet)
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Ştergerea paginilor
Paginile pot fi sterse individual sau în grup.

O singura pagină
Daţi clic - dreapta pe cotorul paginii pe care doriţi să o stergeţi şi selectaţi Ştergere (Delete) 
din meniul contextual.

Mai multe pagini

Pentru a şterge mai multe pagini, selectaţile cum am descris mai sus, daţi clic - dreapta pe unul 
dintre cotoare şi selectaţi Ştergere (Delete) din meniul contextual.

Redenumirea paginilor
Numele de început pentru fiecare pagină este de forma “SheetX”, unde X este un număr. Dacă 
aceasta este acceptabil pentru un registru cu puţine pagini, devine incomod când numărul de 
pagini este mai mare.

Pentru a da unei pagini un nume semnifocativ, puteţi face următoarele:

• Introduceţi numele în câmpul de nume atunci când creaţi pagina, sau

• Daţi clic - dreapta pe un cotor şi selectaţi  Redenumire pagină  (Rename Sheet) din 
meniul contextual şi înlocuiţi numele existent cu unul mai potrivit.

Notă Numele paginilor trebuie să înceapă fie cu o literă fie cu un număr; alte caractere 
inclusiv spaţiile) nu sunt permise, deşi spaţiile pot fi folosite începând cu al doilea 
caracter. Încercarea de a atribui un nume invalid va genera un mesaj de eroare.
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Vizualizare în Calc

Folosirea func iei de scalare (zoom)ţ
Funcţia de scalare (mărire sau micşorare) vă permite să vedeţi mai multe sau mai puţine celule 
în fereastra Calc.

Funcţia poate fi folosită prin mai multe metode:

• Mergând la meniul Vizualizare > Scalare (View > Zoom), sau

• Daţi dublu - clic pe cifra procentului din panoul de statut din marginea de jos a ferestrei.

Imaginea 13. Caseta de dialog pentru scalare.

Ambele metode vor deschide caseta de dialog pentru scalare (Zoom) (Imaginea 13). Acest 
dialog are următoarele opţiuni listate în partea din stânga.

• Întreaga  pagină  (Entire  Page) –  această  opţiune  scalează  imaginea  astfel  încât  o 
întreagă pagină va fi  vizibilă în fereastra Calc.  Pagina (mărimea ei) este definită de 
modelul de pagină care a fost aplicat paginii. Acesta poate fi modificat de la Formatare 
> Pagină >  categoria  Pagină  (Format > Page > Page tab) sau de la  Formatare > 
Stiluri şi formatare > Pagină (Format > Styles and Formatting > Page Styles). În 
general, OOo va arăta cel puţin o pagină în cadrul ferestrei.

• Lăţimea paginii (Page Width) – această opţiune scalează imaginea astfel încât întreaga 
lăţime  a  paginii  va  fi  încadrată  în  lăţimea  ferestrei  Calc.  Pagina  este  definită  şi 
modificabilă ca mai sus. Dacă prima opţiune poate face ca celulele să apară destul de 
mici, această opţiune va păstra o dimensiune mai mare, dar nu va mai fi vizibilă toată 
pagina pe înălţime.

• Optimal –  această opţiune scalează imaginea astfel încât să fie vizibil doar blocul de 
celule selectate. Dacă nu există celule selectate, această opţiune va fi colorată în gri şi 
nu va fi disponibilă, aşa că va trebui întâi să selectaţi nişte celule.
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• Procentaje (Percentages) – această opţiune scalează la un anumit procentaj selectat de 
dumneavoastră dintr-o listă, 100% însemnând dimensiunea obişnuită.

• Variabil  (Variable) –  această  opţiune  scalează  la  un  procentaj  specificat  de 
dumneavoastră după bunul plac. Puteţi folosi săgeţile sus şi jos din dreapta câmpului 
sau să daţi clic de trei ori deasupra câmpului şi apoi să introduceţi valoarea dorită.

Fixarea rândurilor şi coloanelor (Freezing rows and 
columns)
Fixarea vizează un număr de rânduri şi/sau de coloane, obligatoriu cele de la începutul paginii. 
Apoi,  când  deplasaţi  cursorul,  rândurile  şi  coloanele  fixate  îşi  vor  păstra  locul  pe  ecran, 
rămânând astfel vizibile.

Imaginea 14 arată câteva rânduri şi coloane fixate. Linia orizontală mai groasă dintre rândurile 
3 şi 14 şi cea verticală dintre coloanele C şi H delimitează zonele. Rândurile de la 4 la 13 şi 
coloanele de la D la G au fost îndepărtate de pe ecran prin derularea paginii. Deoarece primele 
trei rânduri şi primele trei coloane au fost fixate, ele sunt păstrate în fereastră.

Imaginea 14. Rânduri şi coloane fixate (câte trei)

Puteţi stabili punctul de fixare atât pe rânduri cât şi pe coloane, după cum se vede în Imaginea
14, unde punctul de fixare este C3 (trei rânduri şi trei coloane).

Fixarea unui singur rând sau a unei singure coloane

1) Daţi clic pe capul rândului sub care doriţi fixarea sau pe cel al coloanei la dreapta căreia 
doriţi fixarea.

2) Selectaţi Fereastră > Fixare (Window > Freeze).
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O linie întunecata va marca locul fixării.

Fixarea unui rând şi a unei coloane

1) Daţi clic în celula situată imediat sub rândul pe care îl doriţi fixat şi imediat la dreapta 
coloanei pe care o doriţi fixată.

2) Selectaţi Fereastră > Fixare (Window > Freeze).

Veţi  observa pe  ecran apariţia  a  două  linii,  una  orizontală  deasupra acestei  celule  şi  alta 
verticală  la  stânga  ei.  După  aceasta,  dacă  veţi  derula  ecranul,  celulele  aflate  deasupra  şi 
respectiv la stânga liniilor vor rămâne pe loc, fiind vizibile.

Încetarea fix riiă
Pentru a înceta fixarea rândurilor sau coloanelor, selectaţi  Fereastră > Fixare  (Window > 
Freeze). Liniile de delimitare a zonei fixate ar trebui să dispară.

Împ r irea ferestrei (Splitting the window)ă ţ
Altă modalitate de a schimba vizualizarea celulelor este de a împărţi fereastra – operaţiune 
denumită şi împărţirea ecranului.  Ecranul poate fi împărţit orizontal, vertical sau în ambele 
moduri. Aceasta vă permite să aveţi maxim patru zone din pagină vizibile permanent.

De ce să faceţi aceasta? Îmaginaţi-vă că aveţi o pagină foarte mare şi una dintre celule conţine 
un  număr  folosit  de  trei  formule,  situate  bineînţeles  în  alte  celule.  Folosind  împărţirea 
ecranului, puteţi poziţiona celula cu numărul într-una din zonele vizibile şi fiecare dintre cele 
trei formule în câte o altă zonă vizibilă. Apoi puteţi să schimbaţi numărul din prima celulă şi să 
vedeţi cum sunt afectate celelalte celule.

Imaginea 15. Exemplu de împărţire a ecranului.
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Împ r irea ecranului pe orizontală ţ ă
Pentru a împărţi ecranul pe orizontală:

1) Deplasaţi mausul în bara de derulare verticală, pe partea dreaptă a ecranului, şi plasaţi-l 
peste micul buton de sus cu un triunghi negru.

Imaginea 16. Linia de împărţire a 
ecranului deasupra barei verticale de derulare.

2) Imediat deasupra acestui buton observaţi o linie subtire neagră (Imaginea 16). Mutaţi 
mausul deasupra acestei linii şi se va transforma într-o linie cu două săgeţi (Imaginea
17).

Imaginea 17. Cursorul deasupra liniei de împărţire.

3) Ţineţi apăsat butonul mausului şi va apărea o linie gri, de-a latul întregii pagini. Trageti 
mausul în jos şi această linie va coborâ şi ea.

4) Eliberaţi butonul mausului şi ecranul va fi împărţit în două zone, fiecare cu propria ei 
bară de derulare pe verticală. 

Observaţi în  Imaginea 15, valorile ‘Beta’ şi ‘A0’ sunt situate în partea de sus a ferestrei şi 
celelalte  formule  în partea de jos.  Puteţi  derula  cele  două zone independent.  Astfel  puteţi 
ajunge la valorile Beta şi A0 şi să urmăriţi efectele schimbării lor asupra formulelor din partea 
de jos a ecranului.

Puteţi de asemenea să împărţiţi ecranul pe verticală procedând după cum vom explica mai jos – 
cu aceleaşi rezultate, să fiţi  capabil să derulaţi amble zone ale ecranului independent. Dacă 
realizaţi şi împărţirea verticală şi cea orizontală, veţi avea patru zone independente.

Împ r irea ecranului pe verticală ţ ă
Pentru a împărţi ecranul pe verticală:

1) Deplasaţi mausul la bara de derulare orizontală din partea de jos a ecranului şi plasaţi-l 
deasupra micului buton din stânga cu triunghiul negru.
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Imaginea 18: Linia de împărţire a ecranului pe  
verticală

2) Imediat  la  dreapta  acestui  buton veţi  observa  o linie  subţire  neagră (Imaginea  18). 
Deplasaţi mausul deasupra acestei linii şi se va transforma într-o linie cu două săgeţi.

3) Ţineti apăsat butonul stâng al mausului  şi o linie gri va apărea, de-a lungul paginii. 
Trageţi mausul spre stânga şi această linie se va deplasa şi ea.

4) Eliberaţi butonul mausului şi ecranul se va împărţi în două zone, fiecare cu propria bară 
de derulare orizontală.

Notă Împărţirea ecranului simultan pe orizontală şi pe verticală va genera patru zone, 
fiecare cu propriile bare de derulare pe orizontală şi pe verticală.

Înl turarea împ r irii ecranuluiă ă ţ
• Daţi dublu - clic pe fiecare linie de împărţire, sau

• Trageţi cu mausul liniile de împărţire înapoi la locurile lor de lângă barele de derulare, 
sau

• Selectaţi  Fereastră > Împărţire  (Window > Split). Aceasta va îndepărta toate liniile 
de împărţire existente.

PONT Puteţi de asemenea să împărţiţi ecranul la fel ca la fixarea rândurilor şi coloanelor de 
la  pagina  19.Urmaţi  acei  paşi,  dar  în  loc  ca  să  alegeţi,  din  meniul  Fereastră 
(Window) opţiunea Fixare (Freeze), alegeţi Împărţire (Split).

Introducerea datelor într-o pagină

Introducerea numerelor
Selectaţi celula şi tastaţi cifrele folosind fie tastele corespunzătoare de pe tastură fie cele de pe 
anexa numerică a tastaturii.

Pentru a introduce un număr negativ, fie tastaţi un semn de minus (–) în faţa sa fie îl închideţi 
în paranteze ( ).

În mod obisnuit numerele sunt aliniate la dreapta iar numerele negative au un minus în faţă.
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Introducerea textului
Selectaţi celula şi tastaţi textul. Textul este aliniat în mod obişnuit la dreapta.

Introducerea numerelor ca text
Dacă numărul este introdus cu un 0 în faţă (01481), Calc va îndepărta zeroul. Pentru a păstra 
acel zero (de exemplu în cazul codurilor din numerele pentru telefon), precedaţi numărul cu un 
apostrof, astfel:  '01481. Totuşi,  data este privită acum de Calc ca fiind un text.  Operaţiile 
aritmetice nu vor putea fi aplicate, fiind fie ignorată fie producând o eroare.

PONT Numerele pot avea zerouri ca primă cifră şi să fie tratate ca text dacă celulele sunt 
formatate corespunzător. Dati clic - dreapta pe o celulă şi alegeţi Formatare celule > 
Numere (Format Cells > Numbers). Alegeţi opţiunea referitoare la zerouri.

Introducerea datei şi orei
Selectaţi celula şi tastaţi data sau ora. Puteţi separa elementele cu o bară (/) sau cu o cratimă (–) 
sau  să  tastaţi  ceva gen  10 Oct  03.  Calc  recunoaşte  o largă  varietate  de  formate  de  dată. 
Elementele orei le separaţi cu două-puncte, ca de exemplu 10:43:45.
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